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QUESTION NO: 1

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to filter data in a 
PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose, you are using a 
slicer. After filtering the data, you want to delete the slicer.

Which of the following steps can you take to accomplish the task? Each correct answer represents a complete solution. 
Choose all that apply.

A. Click the slicer that you want to delete on the Options tab in the Slicer type group.

B. Click the Macro setting, and then delete the slicer from the Macro-enabled slicers list.

C. Click the slicer, and then press Delete.

D. Right-click the slicer, and then click Remove .

ANSWER: C D 

Explanation:

Take one of the following steps to delete a slicer:

1. Right-click the slicer, and then click Remove .

2. Click the slicer, and then press Delete.

Incorrect Answers:

Answer options A, B: These are invalid answer options.

References: https://support.office.com/en-us/article/use-slicers-to-filter-data-249f966b-a9d5-4b0fb31a-12651785d29d

QUESTION NO: 2

You work as a Project Manager for Blue Well Inc. The company has a Windows-based network. You want to rename a 
worksheet as Important.

Which of the following steps will you take to accomplish the task? Each correct answer represents a part of the solution. 
Choose all that apply.

A. Click the Insert tab and open the name sheet.

B. Enter the name and click the OK button.

C. Right-click on the Sheet tab and select the Rename option.

D. Delete the old name, type the new name, and then click OK.
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ANSWER: B C 

Explanation:

References: https://support.office.com/en-us/article/rename-a-worksheet-3f1f7148-ee83-404d8ef0-9ff99fbad1f9

QUESTION NO: 3

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013. You 
want to export XMLdata to your Excel 2013 worksheet.

On exporting the XML data, the following error message appears:

"XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE"

Which of the following are the reasons that are causing the above error? Each correct answer represents a complete 
solution. Choose all that apply.

A. The maxoccurs attribute is not equal to 1.

B. The relationship of the mapped element with other elements is not preserved.

C. The element is a recursive structure.

D. The XML map associated with this XML table contains one or more required elements that are not mapped to the XML 
table.

ANSWER: A B 

Explanation:

The various issues with exporting XML data are as follows:

1. MAP CAN BE EXPORTED BUT SOME REQUIRED ELEMENTS ARE NOT MAPPED: Thiserror occurs under the 
following situations:

The XML map associated with this XML table contains one or more required elements that are not mapped to the XML table. 
The element is a recursive structure.

The XML table contains a variety of mixed content.

2. EXCEL CANNOT SAVE THE WORKBOOK BECAUSE IT DOES NOT CONTAIN ANY XML

MAPPINGS: Excel cannot save the user's workbook in the XML Data file unless one or more mapped ranges are created.

3. XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE: An XML mapping cannot be

exported if the relationship of the mapped element with other elements is not preserved due to the following reasons:

The mapped element's schema definition is contained within a sequence with the following attributes:

The maxoccurs attribute is not equal to 1.

The sequence has more than one direct child element defined or has an extra compositor as a direct child. Nonrepeating 
sibling elements with the same repeating parent element are mapped to dissimilar XML tables. Various repeating elements 

https://dumpsarena.co/


DumpsArena - Pass Your Next Certification Exam Fast!
dumpsarena.co

are mapped to the same XML table and the recurrence is not defined by an ancestor element. Child elements from various 
parents are mapped to the same XML table. XML schema constructs a list of lists, denormalized data, or a choice construct.

References: https://support.office.com/en-us/article/issue-verifying-an-xml-map-for-exportfbfcdb77-c2d6-4040-b256-
e584a71151b0

QUESTION NO: 4

You work as a Sales Manager for Maini Industries. Your company manufactures and sells construction equipment.

You have to create a report that will show the highest selling items of each month. The report will be in the following format:

In a workbook, you create a table named Item_table as shown below:

You fill in the required entries in the workbook.
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For the third column of the sheet, you want to use formulas to fill in the values. You want the cells in the third column to get 
automatically filled with the names corresponding to ItemID in the second column. You want the exact values to be filled in 
the column. You select the C2 cell in the third column.

Which of the following formulas will you enter in order to accomplish the task?

A. =VLOOKUP(B2,Item_table,2,FALSE)

B. =VLOOKUP(B2,Item_table,2,TRUE)

C. =VLOOKUP(2,Item_table,B2,FALSE)

D. =VLOOKUP(2,Item_table,B2,TRUE)

ANSWER: A 

Explanation:

In order to accomplish the task, you will use the following formula: =VLOOKUP(B2,Item_table,2,FALSE)

Incorrect Answers:

B: According to the question, you want the exact values in the column.

The TRUE value in the range_lookup argument provides the approximate match.
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Answer options C, D: The VLOOKUP functions used in the formulas have wrong syntaxes.

References: https://support.microsoft.com/en-za/help/181213/how-to-use-vlookup-or-hlookup-tofind-an-exact-match

QUESTION NO: 5

Rick works as an Office Assistant for Tech Perfect Inc. The company has a Windows- based network. Rick has to perform 
the following tasks:

Summarize large amounts of data. Analyze numeric data. Answer unexpected questions about data.

Which of the following actions will Rick take to accomplish the task?

A. He will create the accounting template.

B. He will use stand-alone slicers.

C. He will create a PivotTable report.

D. He will configure form controls.

ANSWER: C 

Explanation:

A PivotTable report is used to summarize large amounts of data, to analyze numerical data, and to answer unexpected 
questions about data.

Incorrect Answers:

A: The accounting template is used for numbering months of a financial year to period numbering.

It is used to compare month to month, actual v budget, quarter to quarter, year to year variances.

It is the initial point for other reports that need the use of months.

B: Stand-alone slicers are referenced from Online Analytical Processing (OLAP) Cube functions. These stand-alone slicers 
can be connected with any PivotTable in future. They can be added by using the slicer button on the Ribbon. They need to 
be manually linked into grids as required. D: A form control is an original control that is compatible with old versions of Excel, 
beginning with Excel version 5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants to simply 
interact with cell data without using VBA code and when he wants to add controls to chart sheets. By using form controls, the 
user can run macros. He can attach an existing macro to a control, or write or record a new macro. These controls cannot be 
added to UserForms, used to control events, or modified to run Web scripts on Web pages.

References: https://support.office.com/en-us/article/overview-of-pivottables-and-pivotcharts527c8fa3-02c0-445a-a2db-
7794676bce96

QUESTION NO: 6 - (SIMULATION)

SIMULATION

Insert a comment in a cell.
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Cell I3

Comment text "If red fill is present, update exchange rates"

ANSWER: Use the following steps in explanation.

Explanation:

Step 1: Right-Click in cell I3, and select Insert comment from the context menu.

Step 2: Type: If red fill is present, update exchange rates
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Step 3: Click cell I3.

You can test by hover above cell I3:

QUESTION NO: 7 - (HOTSPOT)

HOTSPOT

You work as a technician in Tech Perfect Inc. The Network Administrator of the company installs the Microsoft Excel 2013 
application on the network.

You open the application and see various changes in Excel 2013. You have to open an existing worksheet through the 
application. You are unable to find the Office button.

Mark the option that you will click to accomplish the task.

Hot Area:
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ANSWER:

Explanation:

References: https://support.office.com/en-us/article/what-and-where-is-backstage-view-04610088406c-43d0-98a0-
c1999ab4ef53
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QUESTION NO: 8

Rick works as an Office Assistant for Tech Perfect Inc. The company has a Windows- based network. Rick is creating a 
project through Microsoft Excel 2013. The project on which he is working has 98 project tasks and 57 team members. Rick 
wants to check the progress of his project quickly and easily.

Which of the following will Rick use to accomplish the task?

A. Gantt Chart Template

B. Form control

C. Trust Center

D. Accounting template

ANSWER: A 

Explanation:

The Gantt Chart Template Deluxe Edition for Excel is used to generate quick and easy Gantt charts that define the progress 
of a user's projects containing up to 100 project tasks and team members.

Incorrect Answers:

B: A form control is an original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is 
designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data without using VBA 
code and when he wants to add controls to chart sheets. By using form controls, the user can run macros. He can attach an 
existing macro to a control, or write or record a new macro. These controls cannot be added to UserForms, used to control 
events, or modified to run Web scripts on Web pages.

C: Trust Center is where a user can find security and privacy settings for Microsoft Office 2013 programs.

D: The accounting template is used for numbering months of a financial year to period numbering.

It is used to compare month to month, actual v budget, quarter to quarter, year to year variances. It is the initial point for 
other reports that need the use of months.

References: https://excel-gantt-chart-template-deluxe.soft112.com/

QUESTION NO: 9

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2013 and shared it with the 
other employees of the company.

You select the Encrypt with Password option as a protection measure for the document you are sharing. Now, you have to 
specify a password in the Password box in the Encrypt Document dialog box appeared for editing the document. But you 
have forgotten the password.

What will happen in this situation?

A. You will use a new password.

B. You will ask Microsoft to retrieve the password.
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C. You will fetch the password from the list in which you have saved it.

D. You will create a new document.

ANSWER: C 

Explanation:

The various Protect Workbook options are as follows:

1. Mark as Final: This option is used to make the document read-only. When a spreadsheet is marked as final, various 
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes 
read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This 
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet. 2. Encrypt with 
Password: When a user selects the Encrypt with Password option, the Encrypt Document dialog box appears. In the 
Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten passwords, so it is 
necessary for a user to keep a list of passwords and corresponding file names in a safe place.

3. Protect Current Sheet: This option is used to select password protection and permit or prohibitother users to select, 
format, insert, delete, sort, or edit areas of the spreadsheet. This option protects the worksheet and locked cells.

4. Protect Workbook Structure: This option is used to select password protection and selectoptions to prevent users from 
changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet.

5. Restrict Permission by People: This option works on the basis of Window Rights Managementto restrict permissions. A 
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions can be 
applied via a template that is used by the organization in which the user is working. These permissions can also be added by 
clicking Restrict Access.

6. Add a Digital Signature: This option is used to add a visible or invisible digital signature. Itauthenticates digital information 
such as documents, e-mail messages, and macros by using computer cryptography. These signatures are created by 
specifying a signature or by using an image of a signature for establishing authenticity, integrity, and non-repudiation.
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C:\Documents and Settings\Administrator\Desktop\1.JPG

Incorrect Answers:

D: You can create a new document with the same details but it will increase the overhead and is a very time consuming 
process.

References: https://support.office.com/en-us/article/protect-an-excel-file-7359d4ae-7213-4ac2b058-f75e9311b599 

QUESTION NO: 10 - (SIMULATION)

SIMULATION

Reorder all Conditional Formatting rules into a new order of execution.

"Monthy_Billing" Worksheet

Top Rule (Bold and Underline)

Second Rule (Red text)

Third Rule (Pink Fill)

Fourth Rule (Red Text with Strikethrough)
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ANSWER: Use the following steps in explanation.

Explanation:

Step 1: On the Home tab select Conditional Formatting, and click Manage Rules.

Step 2: In the Conditional Formatting Rules Manager, select Show formatting rules for: This worksheet, click on the Bold and 
Underline Rule, and move it to the top with the upward arrow.
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Step 3: Move the Red Text rule to the second place, Pink fill to the third. Will look like:

Step 4: Click OK.
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